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1.1
Introduction

This document shows the required format and appearance of a manuscript prepared for SPIE Press books. Formatting guidelines must be followed rigorously to minimize typesetting efforts after submission. Authors are advised to print this sample manuscript and use it as a reference while preparing their own paper, to ensure all guidelines are met.
1.2
Use of This Template

Authors may use this Microsoft (MS) Word template by employing the relevant styles from the Styles and Formatting list, which is accessed from the Format menu, or in Word 2007, on the “Home” tab, in the “Style” block. Click the bottom right arrow to view the pop-out menu with all of our preformatted styles. Care must be exercised in using the styles to obtain the desired format. To view which style is being used in any part of this document, place the cursor on the line and look in the style list. 
1.3
English
Authors are strongly encouraged to follow the principles of sound technical writing, as found in Ref. 1, for example. In addition, good English usage is essential. Authors whose native language is not English may wish to collaborate with a colleague whose English skills are more advanced. A spell checker can be helpful to discover misspelled words, and authors are encouraged to use The Chicago Manual of Style1 as a reference for punctuation, grammar, and style.
1.4
Page Setup and Fonts

All text and figures, including footnotes, must fit inside a text area 5 in. wide by 8 in. high (21.59 by 27.94 cm). Margins should be 1.7 in. (4.32 cm) on the top and 1.3 in. (3.3 cm) on the bottom; left and right margins should be 1.75 in. (4.44 cm) each; headers should be set at 1.3 in. (3.3 cm), and footers should be set at 1 in (2.54 cm). 
The font Times New Roman is used in the body of the manuscript and in footers. Arial is used for all headers, including the chapter number and title, captions, running headers, and in the sizes and styles shown in Table 5.1. Running headers are inserted by selecting Header and Footer from the View menu.  Pages should not be numbered. The page numbers will be added by the publisher.
Table 5.1 Font sizes and styles.

	Style name
	Font
	Brief Description

	Chapter number

Chapter title
	Arial

Arial
	20 pt, bold

24 pt, bold

	Heading 1
	Arial
	12 pt, bold

	Heading 2
	Arial
	11 pt, bold

	Heading 3
	Arial
	10 pt, bold

	Heading 4
	Arial
	10 pt, italic

	Paragraph
	New Times Roman
	11 pt

	Figure number
	Arial
	9 pt, bold

	Figure caption
	Arial
	9 pt

	Table number
	Arial
	9 pt, bold

	Table caption
	Arial
	9 pt

	Footer
	New Times Roman
	9 pt, hanging indent


1.5
Parts of a Manuscript

This section describes the normal structure of a manuscript and how each part should be handled. In this template, paragraph spacing is done automatically. For example, the appropriate space is automatically added after section headings, and section headings always fall on the same page with the first two lines of the paragraph that follows. Therefore, it should rarely be necessary to force a page break to avoid widows/orphans. Also, note that only a single space should be added between sentences.
1.5.1
Preface

The preface provides the reader with an understanding of the text, including reasons for writing the book, methods of research, the intended audience, and the appropriate prior knowledge that should be possessed by the intended audience. The author’s name and the date should appear flush left at the end of the preface.
1.5.2
Acknowledgments

Acknowledgments can be included in the preface or as a separate section at the end of the preface, if they are longer than a paragraph.
1.5.3
Chapter and title 
Chapters begin 1 in. (2.54 cm) below the top margin and are moved down with the use of hard returns (please see the example above). All chapters begin with “Chapter x,” where “x” is the number of the chapter, followed by the title of the chapter on the next line.
The chapter number is 20 pt Arial font, bold; the chapter title is 24 pt Arial, bold. Titles should be in headline case: capitalize the first element and subsequent elements unless they are articles, or prepositions. Do not begin titles with articles (e.g., a, an, the) or prepositions (e.g., on, by, etc.). Avoid the use of acronyms in the title, unless they are widely understood. Appendix A contains more about acronyms.

1.5.4
Body of paper

The body of the paper consists of numbered sections that present the main findings. These sections should be organized to best present the material. See Section 3.1 for section formatting instructions.
1.5.5
Appendices

Auxiliary or supplemental material that is best left out of the main body of the paper may be included in the appendices for example, derivations of equations, proofs of theorems, and details of algorithms. Appendices are enumerated with upper-case Latin letters in alphabetic order.
1.5.6
References 

The References section lists books, articles, and reports that are cited in the paper. This section does not have a section number. The references are numbered in the order they are cited. Examples of the format to be followed are given at the end of this template.
For books,1–3 the listing includes the list of authors (last name of first author, and initials, then initials and last name of subsequent authors), book title (in italics), page or chapter numbers, publisher, city, and year of publication. Journal article references,4,5 include the author list, title of the article (in quotes), journal name (in italics, properly abbreviated), volume number (in bold), inclusive page numbers or citation identifier, and year. A reference to a proceedings paper or a chapter in an edited book6,7 includes the author list, title of the article (in quotes), conference name (in italics), editors (if appropriate), volume title (in italics), volume number if applicable (in bold), inclusive page numbers, publisher, city, and year. For author listings of more than three names, the use of “et al.” (nonitalic) is permitted.
The references are numbered in the order of their citation. Citations to the references are made using superscripted numerals, as demonstrated in the preceding paragraph. Two or more references should be separated by a comma with no space between them. Multiple references should be displayed with an endash (​​ctrl + minus sign on number pad) between the first and last numbers [1–4]. One may also directly refer to a reference within the text, e.g., “as shown in Ref. 3....” 

Footnotes may used to provide auxiliary information that doesn’t need to appear in the text, e.g., to explain measurement units. They should be used sparingly.

1.5.7
Biographies

The author should provide a brief professional biography not to exceed 250 words, along with a photograph. Biographies should be placed at the end of the manuscript. Personal information such as hobbies or birthplace/birthdate should not be included.
1.6
Section Formatting
Type each section heading on a separate line using the appropriate style from the style list. Sections should be numbered sequentially, starting with the first section, except for the acknowledgments and references. All section headings should be left justified. Main section headings begin with the section number, are in 12-pt, bold Arial font, and headline case. 
Paragraphs that immediately follow a section heading are leading paragraphs and should not be indented, according to standard publishing style. The same goes for leading paragraphs of subsections and sub-subsections. Subsequent paragraphs are standard paragraphs, with 0.25-in. indentation. There is no additional space between paragraphs. In this MS Word template, use the Paragraph 1 style for leading paragraphs and the Paragraph 2 style for all subsequent paragraphs.

1.6.1

Subsection headings

Only the first word of a subsection heading is capitalized. The rest of the text is not capitalized, except for proper names and acronyms (the latter should only be used if well known). Subsection numbers consist of the section number, followed by a period, and the subsection number within that section, without a period at the end. The heading is left justified and is Arial 11 pt, bold.
1.6.1.1 Sub-subsection headings 
The first word of a sub-subsection is capitalized. The rest of the text is not capitalized, except for proper names and acronyms (the latter should only be used if well known). The heading is left justified and Arial font 10 pt, bold. 
Paragraph heading  This template has a level 4 heading option that is 10 pt Arial font in italic.
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Figure 1.1 Example of a figure caption.
1.7
Figures and Tables

It is preferable to have tables and figures appear at the top or bottom of the page, if possible.
1.7.1
Figures

Figures are numbered in the order in which they are called out in the text and named by chapter number and sequence. They should appear in the document in numerical order and as close as possible to their first reference in the text, which should be “Fig. x.x” or “Figure x.x,” if beginning a sentence. It may be necessary to move figures or tables around to enhance readability. 
Figures, along with their captions, should be separated from the main text by 0.25 in. Figure captions are centered below the figure or graph. If the caption is two or more full lines, it should be fully justified. Figure captions start with the word “Figure” in front of the figure number and are 10-pt Arial. See Fig. 1.1 for an example.

1.7.2
Tables

Tables are numbered in the order in which they referred to. They should appear in the document in numerical order and as close as possible to their first reference in the text. Table captions are handled identically to those for figures, except that they appear above the table, and when called out in the text, the word “Table” is always spelled out. See Table 1 for an example. 

1.8
Miscellaneous Formatting Details

It is often important to refer back (or forward) to specific sections. Such references are made by indicating the section number, for example, “In Sec. 2 we showed…” or “Section 2.1 contained a description….” When the section reference starts a sentence, Section is spelled out; otherwise use its abbreviation, “Sec.” References to figures and equations are handled in the same way.

At the first occurrence of an acronym, spell it out (unless it is widely known such as CCD, LED, UV, 2D, NA), followed by the acronym in parentheses, e.g., noise power spectrum (NPS).

At times it may be desired, for formatting reasons, to break a line without starting a new paragraph. Line breaks should be inserted using Shift+Enter instead of the Enter key.
Lists are numbered as follows:

(1) Item one,

(2) Item two,

(3) Item three,

(4) Item four, and 

(5) Item five.
1.8.1
Formatting equations
Equations may appear inline with the text, if they are simple, short, and not of major importance, e.g., a = b/c. Important equations appear on their own line and are centered.  For example, “The expression for the field of view is
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where a is the …” Principal equations are numbered, with the equation number placed within parentheses and right justified. Authors are strongly encouraged to use MS Word Equation Editor or MathType to create both in-text and display equations.
Equations are considered to be part of a sentence and should be punctuated accordingly. In the above example, a comma appears after the equation because the next line is a subordinate clause. If the equation ends the sentence, a period should follow the equation. The line following an equation should not be indented unless it is meant to start a new paragraph.

References to equations include the equation number in parentheses, for example, “Equation (5.1) shows …” or “Combining Eqs. (5.2) and (5.3), we obtain….” Note that the word “Equation” is spelled out if it begins a sentence but is abbreviated as “Eq.” otherwise.

1.8.2
Formatting theorems
To include theorems in a formal way, the theorem identification should appear in a 10-pt bold font, left justified, and followed by a period. Formal statements of lemmas and algorithms receive a similar treatment. The text of the theorem continues on the same line in normal, 10-pt font, for example:

Theorem 1.  For any unbiased estimator….
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� To insert a footnote, use the Insert menu, select Reference, then Footnote, change the number format to the style of asterisk, dagger, double-dagger, etc., and click OK.
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